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Hyperion Overview 
Overview 
 
Hyperion is a centralized, Excel and Web-based planning, budgeting and forecasting solution 
that integrates financial and operational fiscal processes and improves business predictability. 
Support Units and Responsibility Centers enter budget data through web forms using a web 
browser. Current year budget and two years of actual data are provided to facilitate the 
budgeting process. Support Units and Responsibility Centers can also choose to open these 
same forms in Smart View which is integrated into Excel to input and submit the budget through 
Excel or use the Smart View Ad Hoc functionality.   
 
UF Budget Cycle  
There are important milestones throughout the UF Budgeting process you should be aware of 
depending on whether you are budgeting for a Support Unit (SU), Responsibility Center (RC), 
College, State Funded Center (SFC) or hybrid. 
 
Starting in Noveember of every year, Support Units make their budget requests for the 
upcoming fiscal year to the UF Budget Office.  The requests are reviewed and approved by 
Senior Vice Presidents and the President. 
 
Click here for SU Budget Request Whole Cycle Document 
 
Starting in May/June, all budget personnel will receive their final budgets and can then manage 
and distribute the monies as appropriate across their Budget Preparation and All Funds Budget. 
 
Click here for All Funds Budget Whole Cycle Document 

 
 
Logging In 
  
The Hyperion budget submission application is incorporated to the myUFL portal. After logging 
into myUFL, navigate to the NavBar.  Go to Main Menu > Budgeting > UF Hyperion Budgeting.  
Internet Explorer 11 is the recommended browser.   
 

 
 
 
 
 
 
 
 
 
 

http://training.hr.ufl.edu/instructionguides/hyperion/hyperion_whole_cycle-su_budget_request_cycle.pdf
http://training.hr.ufl.edu/instructionguides/hyperion/hyperion_whole_cycle-all_funds_budget.pdf
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Hyperion opens with the HomePage displayed by default. 
 

 
NOTE: 
You may choose to display either the HomePage or the UBO_PSPB Application as the opening 
page by changing this setting in Hyperion User Preferences. 
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NOTE: Also note that previous fiscal year data will appear on the HomePage.  For example, 
above you can see FY14PSPB, FY15PSPB, and FY16PSPB.  As the years pass, you will see 
FY17PSPB, FY18PSPB, etc.  These applications are the view only data that was entered for 
that fiscal years submissions. 
 
 
Setting Hyperion User Preferences 
 
Changing Hyperion Display Settings 
  
The display options must be established prior to using the Hyperion application for requesting 
UF budgets. It allows you to set the default page and the display options such as thousand 
number separator, demical separator et. al. It also allows you to set the user variables to display 
specific content in the forms.  

 
Set the default page when you log in to Hyperion 
1. Go to myUFL and navigate to the NavBar.  Click on Main Menu > Budgeting > UF 

Hyperion Budgeting. 
 

2. Go to File > Preferences from the Menu bar. 
 

 
 

3. If you prefer the Homepage to be the default page when you log into Hyperion, from the 
General section, you can keep the content for Default Startup Options to be 
“Homepage”. If you prefer the UBO_PSPB to open by default, from the General section 
select the Home Page drop down arrow and choose Application. 
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4. Now select the Application drop down arrow, choose Planning > UBO_PSPB 
 

 
 

5. Click OK. 
 

Note: Most users keep Homepage as the default page. It allows the users to look at all the 
applications that are available in Hyperion. 
 

Set Display Options 
You must go to UBO_PSPB first to set the display options. 
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6. Open UBO_PSPB. 
 

7. Go to File > Preferences. Or click on the Preferences section on the left side menu 
area.  

 

 
 

8. Go to Planning. Click on the Display Options tab. 
 

 
9. Select your desired options. 
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You are welcome to customize your desired Display Options settings as you see fit.  Some 
suggested default settings include: 

 
Number Formatting 
• Thousands Separator – choose Comma 
• Decimal Separator – choose Dot 
• Negative Sign – choose Prefixed Minus 
• Negative Color – choose Black 
 
Page Options 
• Indentation of Members on Page – choose Indent based on hierarchy 
• This option dictates the look and feel of data categories on web forms 
 
Other Options 
• Using the default settings is highly recommended 

 

 
 
      Changing Hyperion User Variable Settings  

As part of the Hyperion preference setup, you will indicate three User Variable settings. 
These variables define the data content in the forms. For the All Funds Budget cycle, the 
variables should be setup as below.  
 

• Scenario: Budget  
• Version: Working  
• Year: FYXX (the fiscal year you are budgeting for)  

  
10. Click on the User Variable Options tab. Type in or select the proper variables. 
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11. Click Save, then OK. 
You are now ready to navigate through the application.  
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Workspace 
Hyperion Navigation 
 

 

  
 
Toolbar Icons   
 

 Save Save the input data 

 Refresh Refresh  the form 

 Print Print the current screen 

 Adjust 
Adjust the selected cell value by a percentage or by 
a value  

 Grid Spread Spread value  

 Mass Allocate Run a mass allocation  

Menu Bar Tool Bar Content Area 

Open 
Application 

View Pane 
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 Comment Add or edit comment to the selected cell. 

 
Lock/Unlock 
Cells Lock or unlock cells when spreading data.  

 
Supporting 
Detail Add or edit supporting details to selected cell. 

 
Add/Edit 
Document 

Add or edit attached documents for the selected 
cell. 

 Instructions Show the instruction details for the open data form. 

 
Open in Smart 
View 

Open data from in Smart View. (This button does not 
work and will not be used.) 

 
 

Some tools can be accessed by right-clicking on the desired area of the form and displaying the 
shortcut menu. 
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Hyperion Processes 
 
There are two specific and individual processes you will complete using Hyperion to 
successfully submit your budget each fiscal year.  Those processes include multiple procedural 
steps and are titled: 
 

• Budget Preparation 
• Budget Submission 

  

Budget Preparation and All Funds Budget are now under the same place My Task List. You can work on 
the postions/employees changes and the operating budget in the same area (or mode).  
 

 
 

 

Budget Preparation Overview 
The annual Budget Submission process includes completing relevant procedures within both 
Budget Preparation and Budget Submission before submitting to the University Budget Office 
(UBO). 
 
In this section, we will cover the available procedures in Budget  Preparation in the order the 
University Budget Office recommends as best practice.  Required Budget Preparation 
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procedures should be completed first, prior to completing Budget Request Submission 
procedures. 
 
There are a total of 15 budget prep procedures displayed in the image below from which you 
may choose to successfully prepare your budget.  
 
Before we go into the details of the budget prep procedures. We recommend you to run some of 
the Hyperion report first to review the current employees and positions in your organizations and 
decide the personnel changes you need to make.   
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Running Hyperion Reports 
Please keep in mind that the reports will not be updated until after the push has occurred in 
Hyperion.  The push runs every two hours starting at 7am and ending at 7pm Monday thru 
Friday.  On Saturday and Sunday the push will run every two hours starting at 11am and ending 
at 7pm. 
 
We have found that the push typically takes ½ hr to run.  We recommend you run the reports an 
hour after the push times (7:30am, 9:30am, et al.) to see any changes that were made before 
the push occurred.   
 
Navigation to all reports 
 

1. Log into myUFL and navigate to the NavBar.  Go to Main Menu > Enterprise Reporting 
> Access Reporting. 

 
2. From the Public Folder tab, select Financial Information > Budget > UF Budgeting. 

Once inside you will choose the report you want to run from the list provided. 
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Budgeted Lines + Benefits Report 
 
The Budgeted Lines + Benefits Report gives you a list of where all employees are currently 
budgeted and their benefits within Hyperion. This report can be run by the following additional 
search criteria Employee, Entity (Home Department), Comp Entity (Earnings Department), and 
Filled or Vacant.  Please note Comp Fund (Earnings Fund), Comp Program (Earnings Fund), 
Comp Dept Flex (Earnings Dept Flex) are available search criteria.  We recommend that this 
be the first  step in the budgeting process so that you know how the people data was 
loaded into Hyperion at the time of the snap shot.  

 
1. Select Budgeted Lines + Benefits 

 
 

2. Choose your required search criteria. 

 
 

3. Choose your additional search criteria.  In this example, we will use HR_3201 data.  
After entering scroll to bottom of form or top of the form. 
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Please note that there are two types of Entities.   
 
One is the employee’s home department which is referred to as “Entity” on the 
search criteria page.  The home department starts with “HR_”.   
 
The other one is the employee’s earnings department which is referred to as 
“Comp Entity” on the search criteria page.  The earnings department starts with 
“D_”.   
 
If you search by home department, the report will return all the 
positions/employees who are administrated in that department.  If you search by 
the earnings department, the report will return all the positions/employees who 
are paid by that department. 
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4. Click Finish and wait for the report to run. 
 

 
5. Review your report. 

 

 
 

NOTE:  At this time each person has at least two rows of data.  The one row of data is the 
salary expense data line and the one row is the benefit data line.   
 
NOTE: You do not have to run all of the below reports before you continue on with your 
budgeting work this is just to show you how to run the additional reports that are available for 
your use. 
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Additional Earnings + Benefits 
 
The Additional Earnings + Benefits Report gives you a list of any employee where that 
employee has had additional earnings and their benefits input into Hyperion. This report can be 
run by the following additional search criteria Employee, Entity (Home Department), Comp 
Entity (Earnings Department), and Filled or Vacant.  Please note Comp Fund (Earnings Fund), 
Comp Program (Earnings Fund), Comp Dept Flex (Earnings Dept Flex) are available search 
criteria. 

  
1. Select Additional Earnings + Benefits 

 

 
 

2. Choose your required search criteria. 
 

 
 

3. Choose your additional search criteria.  In this example, we will use HR_3201 data.  
After entering scroll to bottom of form or top of the form. 
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4. Click Finish and wait for the report to run. 
 

 
5. Review your report.  
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Benefit Selection 
 
The Benefit Selection Report gives you a list of all employees benefit selections that have been 
input into Hyperion. This report can be run by the following additional search criteria Employee, 
Entity (Home Department), Comp Entity (Earnings Department), and Filled or Vacant.  Please 
note Comp Fund (Earnings Fund), Comp Program (Earnings Fund), Comp Dept Flex (Earnings 
Dept Flex) are available search criteria 

 
1. Select Benefit Selection 

 
 

2. Choose your required search criteria. 
 

 
 

3. Choose your additional search criteria.  In this example, we will use HR_3201 data.  
After entering scroll to bottom of form or top of the form. 
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4. Click Finish and wait for the report to run. 
 

 
5. Review your report. 
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Budget Preparation Processes 
Manage Position and Employee Data Forms 
 
Maintain position data 
This form should only be used to make changes to positions.  Updating employee distributions 
and data is performed within a different form. 

Maintain filled positions 
This form should only be used to make changes to existing and to-be-hired employees.  This is 
where you would make any changes to distributions, salary, benefits, etc. 

Maintain employees by position 
Maintain employees by position was originally designed to display positions and employees 
together in one form, but due to the level of complexity and resulting confusion, the UBO does 
not recommend using this form.  
 
Fill to-be-hired vacancies 
This form was originally designed to replace to-be-hired employees with named employees if 
they are hired.  Because we don't add new hired employees to Hyperion after the snap shot, 
you will never need to use the Fill to-be-hired vacancies functionality.  In this training, we still 
show you the steps on how to fill a to-be-hired vacancy.  However, keep in mind you will not 
need to do that in Hyperion.  This form is currently used by the departments to review all the to-
be-hired employees. 
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Update Current Employees’ Distributions & Data 
 
This procedure is used to make changes to particular parameters of an employee’s distribution, 
such as changing an employee’s Entity. 
 

1. From the Budget Preparation > Manage position and employee data > Maintain 
filled positions form, choose your desired Entity from the Entity drop down field. 

 

2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 

 
 

3. Click the Distributions tab. 

 

In this example, we will be changing the employee’s Entity and assigning the appropriate 
Chartfield String.  If any data is missing addressing these segments will clear the red cell color. 

4. Click in the desired allocation Entity Segment field and click the Entity Segment drop 
down arrow. 

5. Enter the desired Entity number into the Search field (e.g., "1302").   
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NOTE: When searching, you do not have to type D_  in the Entity field.  You can just 
type in the first part of the department ID and the list should automatically move to the 
correct options.  You may also choose to scroll to the appropriate list item.  

 
5. Click the new desired Entity. 

 

6. Click the Fund Segment drop down field. 

7. Click the desired Fund/Budget Reference/Source of Funds option (e.g., 101-CRRNT-
NO_SOF). 
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8. Click the Program Segment drop down field. 
 

9. Click the desired Program option (e.g., PRG_1100).  

 

10. Type No Dept Flex into the Dept Flex drop down field. 

11. Make any changes to the Allocation Start and End Dates if needed. 

12. If any changes are needed to the Percentage Allocation field, make those here.   
NOTE:  You must have a number in the percentage cell and all lines must be 100% in 
total.  Do not leave any 0% distribution lines. If you do not need that line please delete 
the allocation not being used.  

 
13. Click the Save button, then OK button. 

NOTE:  If you had any red or yellow fields, they no longer appear once you save your 
changes. 

 
 
Add an Additional Distribution for the same Employee 
It’s not uncommon for an employee to hold multiple positions or have multiple distribution 
sources at UF.  This procedure covers how to add an additional distribution for the same 
employee. 
 

1. From the Maintain filled positions form, choose your desired Entity from the Entity 
drop down field, if needed. 
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2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 

 
3. Go to the Distributions tab. 

4. Right-click the last Allocation label.  

5. Click the Add Distribution Information link.  

 

6. Enter the Effective Start or End Date if it’s different. 

7. Click the Add button.  
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8. Once the additional allocation appears, select an entity from the Entity drop down list 
and select the appropriate department from the list. 
NOTE:  You may need to search for the desired entity.  

NOTE:  Red cells indicate required data that is currently missing. 

 

9. Click the Fund Segment, Program Segment field, Dept Flex Segment, and Allocation 
Start and End Dates and enter the appropriate data.  Follow steps 7 – 11 from 
previous procedure, as needed. 

10. Make changes in the Percentage Allocation fields of both allocation lines. 

NOTE: Keep in mind, the combination of all distribution lines must equal 100% 
allocation.  Please do not leave any 0% distribution lines.  If it is not needed delete the 
distribution allocation. 
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NOTE:  In this example, the 2nd allocation was altered so all 3 allocations would total 
100%. 

11. Click the Save button, then the OK button. 
NOTE:  Remember any red or yellow cells should clear after saving. 

 

Delete a Distribution  
1. From the Maintain filled positions form, choose your desired entity from the Entity 

drop down field, if needed. 

 

2. Right-click on the name of the employee for which you wish to change the distribution 
and select Edit Employee Details. 
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3. Go to the Distributions tab.  

4. Right-click the Allocation label you wish to delete.  
 

5. Select Delete Distribution Information. 

  

6. Updae the Percentage Allocation field(s) of the remaining allocation(s) to equal 100%. 
NOTE:  Remember, all lines must add up to 100. 

  

8. Click the Save button, then the OK button. 
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Calculate and Allocate Compensation Budgets per Edit 
 
After each edit you make, you may choose to calculate and allocate.  These procedures will 
process all needed calculations and allocate the updated data to the Budgets Submission mode 
within Hyperion. 
 
These procedures can take a long time depending on your area and number of employees.  As 
such the University Budget Office recommends you run these procedures from the Budget Prep 
panel once all edits/updates are done. 
 
If you choose to calculate and allocate after each edit, it’s very important that you note where 
you are before running these procedures as they are very sensitive to location to run accurately.   
 
For example, if you are on the main Maintain position data or Maintain filled positions forms, you 
must right-click on the exact position row you just edited for the calculate and allocate 
procedures to run successfully.  Otherwise, the edited data may not calculate and allocate 
correctly. 
 
If you are in Edit Employee Details, you can right click on any input cell on any tab (except for 
the General tab) to run the calculate and allocate procedures for this position. 
 

 
1. Right click anywhere in the main portion of the edited position. 

 

 
 
2. Click Calculate Compensation Expense. 
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3. Confirm the calculation procedure was successful by noting the message that appears at 
on the window. 

 

 
4. After the Launch Business Rules window closes, right click within the same cell on the 

form again. 
 

5. Choose Allocate Compensation Budget to GL Accounts. 
 

 
 

NOTE:  You will see an animated blue circle within the Launch Business Rules window while 
the process is running.  See image below. 

 
 
 

6. Confirm the procedures have completed successfully by noting the message that 
appears on the form. 
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NOTE:  Sometimes the Launch Business Rules window gets stuck.  If you notice the calculation 
or allocation has been running for several minutes, you can check to make sure the rule has 
finished running by clicking Tools>Job Console from the Menu bar.   
 
If the last column says “Completed”, the procedure has run successfully.  If not completed, click 
Tools > Job Console again to refresh the screen until the job reads Completed. 

 

 
 

Assigning an Existing Employee 
 
If you know you will be hiring a new current full time UF employee from another department 
before the snap shot was taken you will need to add them into Hyperion so that you can account 
for their salaries.  This process must be started by using the Maintain position data form and 
finished using the Maintain filled positions form. 
 
NOTE:  The snap shot is the status of the data in PeopleSoft on a particular date that is then 
loaded into Hyperion as the base data. 
 

1. From the Maintain position data form, right click the line of the position for which you 
want to assign an existing UF employee.  Make sure the position status is Vacant. 
NOTE:  If the position is listed as Not Budgeted, complete the following steps to assing 
FTE to the position first. 

a. Right click on position and choose Edit Position Details 

b. Click the FTE tab 

c. Right click on assignment label and choose Update FTE 

d. Enter FTE value and the Start and End Dates 
NOTE:  Leave the End Date blank to make this an ongoing change. 

e. Click Add, then OK. 
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2. Click the Assign Employee option and click the Assign Existing Employee.  

 

3. Click in the Select Employee field, delete any default text and enter the UFID of the 
appropriate employee.  
NOTE:  the UFID must start with UFID_. 

 

4. Enter the correct FTE, Effective Date, Union Code and Full/Part Time status, if 
different from position defaults.  
NOTE: All these fields are required. 

5. Click the Assign button.  
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6. To confirm the change, click the Maintain filled positions form and verify the assigned 
employee data appears associated with the proper position.  

 

 
7. Right click on name of newly assigned existing employee and choose Edit Employee 

Detail to make any needed distribution and salary changes.   
 
8. Click Save button. 

NOTE:  Remember to run the calculations for changes to become active. 
 
 
 

Assigning a To-Be-Hired Employee   
 
You would assign a To-Be-Hired employee for those positions not yet budgeted, but will be in 
the future or for new employees hired after the snap shot was taken.  To include the budget 
information for the future employee in your budget preparation procedure, you would assign a 
To-Be-Hired employee as a place holder. 
 
 

1. From the Maintain position data form, locate the position for which you wish to assign a 
To-Be-Hired employee.  

 

2. Notice the Occupancy Status for this position will indicate “Not Budgeted” or “Vacant”.  If 
the position is listed as Not Budgeted, please go to step 3.  If the position is vacant, 
please go to step 12. 

3. Right click on the position and choose Edit Position Details. 
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4. Go to the FTE tab. 

 
 

5. Right-click anywhere on the screen and choose Update FTE.  

 

7. Input the FTE for this position.  

8. Remove the Effective End Date.  
If you do not remove the end date it adds an unnecessary FTE line for the next available 
date sequence. 

9. Click Add, then click OK. 
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10. Confirm the assignment appears on the FTE page. 

 

11. Click the Maintain position data form again and notice your position should now read 
Vacant in the Occupancy Status field.  

 

12. Right-click the Position number.  
 

13. Click the Assign Employee on the pop-up menu.  

14. Click the Assign To-Be-Hired Employee option.  
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15. Enter the name of the new employee or a placeholder name or description if unknown.  
NOTE: If you know the UFID and want to input it best practice is to input it as 
UFID_XXXXXXXX  otherwise if you input a number only the system will treat it as a 
dollar figure and add a decimal and cents.  

16. Be sure to indicate the correct Full/Part Time status, Union Code, FTE and Effective 
Date, if different from default.  

17. Click the Assign button.  

  

18. Note the message indicating the Position was filled successfully and the Occupancy 
Status of the position is now "Filled."  
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19. Click on the Maintain filled positions form and find the To-Be-Hired employee just 

assigned. 
 
20. Right-click on the To-Be-Hired employee and choose Edit Employee Details. 

 

 
 

21. If you changed the default FTE value in step 16 above, choose the FTE tab to ensure 
you have a valid FTE. 

 

 
22. Choose the Salary tab and ensure you have a valid salary.  If not, input the new salary 

dollar amount. If changes are made, be sure to save. 
 
23. Choose the Benefits Elections tab and ensure you have valid benefits and save. 
 
24. Choose the Distribution tab and input your distribution information and save.  
 
25. Run both the Calculate and Allocate procedures.   
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Employee Status Change 
 
Common status changes are to inactive (due to maternity leave, military leave, retirement part 
way through the fiscal year, etc.)  

 
1. From Maintain filled positions form, right-click the relevant employee for which you are 

changing status.  
 

2. Click the Edit Employee Details.  
 

3. Click the Status Changes tab.  
 

4. Right-click the blue assignment label of the assignment you wish to change.  

5. Click the Change Status option.  

 

6. Double click the Select Status drop down field. 
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7. Click the appropriate status (e.g., Maternity, Inactive, On Sabbatical, etc.).  

 

8. Enter the desired information into the Enter Effective Start Date field (e.g., "11/4/16") 
and Enter Effective End Date as appropriate.  

9. Click the Change button at bottom of page.  

 

 

10. Confirm the additional allocation displays with the appropriate Action. 

 

11. Go to General tab and change the appropriate Assignment End Date to 11/3/16 to 
reduce the amount of salary expense being charged for this individual to the appropriate 
time period. 
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12. Click the Save button, then the OK button. 

11. Run the Calculate Compensation Expense and Allocate Compensation Budget to GL 
Accounts.  

13. Right-click within any form cell to access the pop-up menu.  

14. Click the Return to Previous Data Form option.  
 

 
 
 

Removing an Assignment 
 

1. From the Maintain filled positions form. 
 

2. Right-click the Name of the individual of which you want to delete. 
 

3. Select Delete Employee Assignment.  
 

 
 

4. Once the process has run you will now notice that the employee is no longer listed in the 
Maintain filled positions form. 
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Change FTE 
 
Occasionally the Full Time Equivalency (FTE) of a position or person may change.  Examples 
are full-time positions changing to part-time, part-time positions changing to full time or a 
different part-time status.   
 
NOTE:  Prior to completing the Change FTE procedure, please check the Default Weekly Hours 
cell to ensure you are adjusting your FTE correctly.  Default Weekly Hours listed as 40 is 
equivalent to 1.0 FTE.  Be aware that some employees have default weekly hours of 20 (not 
40).  The equivalent FTE for this would still be 1.0, not 0.5.  If you inputted 0.5, that would be 
equivalent to 10 hours, not 20. 
 

 
FTE may be changed either per position or per employee. 
 
To change the position FTE only. 

1. From the Maintain position data form, right click on the position to which you wish to 
change the FTE.   
 

2. Click the Edit Position Details option. 
 

 
 

3. Click the FTE tab. 
 

4. Right-click in the Proposed FTE field. 
 

5. Select Update FTE from the pop-up menu.  
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In this example, we are changing the position from a 1.0 FTE to a 0.5 FTE. 

 
6. Replace the 1 in the Enter FTE field with .5. 
 
7. Select the default data in the Effective End Date field. 

 
8. Press [Delete] on the keyboard to remove the Effective End Date to make this an 

ongoing change. 
 

9. Click the Add button, then click OK. 
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10. Confirm the assignment updates correctly. 

 

  
 
To change the FTE for an employee. 
 

1. From the Maintain filled positions, right click on the name of the individual you wish to 
change the FTE.   

 
2. Click the Edit Employee Details option. 

 
3. Click the FTE tab. 

 
4. Right-click in the Proposed FTE field. 

 
5. Select Update FTE from the pop-up menu.  

 

 
 
In this example, we are changing the position from a 1.0 FTE to a 0.5 FTE. 

 
6. Replace the 1 in the Enter FTE field with .5. 

 
7. Select the default data in the Effective End Date field. 

 
8. Press [Delete] on the keyboard to remove the Effective End Date to make this an 

ongoing change. 
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9. Click the Add button. 
 

 
 

10. Confirm the assignment updates correctly. 
 

 
 
 

Promote a Position and Employee including Fringe Benefit changes 
 
This procedure would be used when you are hiring a new employee and do not have an 
appropriate vacant line for that position.  You can use any one of the vacant lines you have and 
change the Job title and, if needed, change the Salary Admin plan which adjusts the fringes.    
 

1. From the Maintain position data form, select the vacant position for which a promotion 
will be provided. 
 

2. Click on the job name cell. 
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3. Click the job drop down arrow. 

 

 
4. Use the Search field to search for a position name or job number. 

 
5. Once found, select the position name or job number you want. 

  
NOTE:  The cell may flash to yellow to indicate a recent edit has not yet been saved. 
 

6. Click the Save button, then click OK. 
 

7. If the salary admin plan remains the same, skip to step 22.   
 

In this example, we need to change the benefits from a Non-Exempt Staff rate to a Exempt rate. 
 
 
Change the Salary Admin Plan 
 

8. Right-click on the newly changed position.  
 

9. Choose Edit Position Details. 
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10. Click the Salary tab.  Notice the Salary Admin Plan still says TU2N which is a Non-

Exempt salary admin plan. 
 

 
11. Click the Fringes tab and notice the fringes are Non-Exempt fringe rates. 

 
 

12. Go back to the Salary tab and right click on any of the cells in the Position Details 
section. 

 
13.  Click Delete Salary Information. 
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14. Right-click on any cell in the Position Details section and choose Add Salary 
Information to add a new salary admin plan.  

 
15. Click the Salary Grade Select Members icons to search for and locate the appropriate 

salary grade for this position. 

 
 

In this example, we will choose TA12, which is a 12 month TEAMS Exempt Salary Admin Plan. 
 
16. Expand the Salary Grades and Faculty categories, and then click TA12. 

 
17. Once TA12 is chosen click the right arrow to send it over to the Element area on the 

right hand side and then click OK.  
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18. From the Add Salary Information window, adjust your Effective Start Date if needed.  In 
this example, we will leave it at 7-1-2016. 
 

19. Click the Add button. 
 
After adding the new salary, you must run the Calculate Compensation Expense for the new 
Fringe Benefit to be reflected. 
 

20. Right-click on any cell in the Position Details section and choose Calculate 
Compensation Expense. Once it is finished, run the Allocate Compensation Budget 
to GL Accounts calculation.    
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21. Go to the Fringes tab and notice the fringes are now Faculty fringes. 

 
 
 

Promote an Individual 
 

22. Click Maintain filled positions from the Budget Prep panel. 
 

23. Click on the job name and select the drop down arrow. 

  
24. Use the top field to search for a position name or job number. 

 
25. Click the position name or job number you want. 
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NOTE:  The cell may flash to yellow to indicate a recent edit has not yet been saved. 
 

26. Click the Save button, then click OK. 
 

You will update the Salary and Fringe benefit, if needed. 
 

27. Right-click on the name of the employee holding newly changed position.  
 

28. Choose Edit Employee Details. 

 
 

29. Repeat steps 10 – 21 above if you need to change the salary admin plan. 
 

30. Click the Save button. 
 

31. Run Calculate compensation budgets and Allocate compensation to general 
ledger accounts as needed. 
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Add Overtime Pay or Additional Earnings  
 
This procedure allows you to apply overtime or additional earnings to an employee’s salary 
information.  Examples of when overtime or additional earnings would be if you have a person 
that will need to work overtime, SPI, or is a Sr. Level manager and has additional earnings they 
receive. 
 

1. From Maintain filled positions, right click on the name of the person to whom you 
want to add overtime.  
 

2. Click the Edit Employee Details option. 
 

3. Click the Additional Earnings tab. 
 
4. Right-click underneath the section that states “Right-click and add Additional Earnings 

Elements”. 
 

5. Click the Add Additional Earnings option. 
 

 
 

6. Click the Enter Additional Earning Select Members drop down icon.  

 

7. Click the Display Properties icon. 
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8. Click the Alias menu.  

 
 

9. Select OTS Overtime. 
 
NOTE: In this example we are selecting an overtime payment.  You would choose the 
correct additional earnings for your purpose. 

 
10. Click the right arrow to move the item to the right side. 

11. Click the OK button. 
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12. If you want to make this effective as of July 1, 2017, click inside the Effective Start Date 
field. For example, change the date to "7-1-2017". 
 

 
 

13. Click the Add button. 
 

14. Click in the Override Option Value field and enter the Amount of the additional 
earnings. For example, enter "500.00". 

 

 
 

15. Click the Option End Date field and enter the date this option amount will end. For 
example, enter "7-30-17". 
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16. Click the Value Type Input field and a drop down list will appear. Select Amount - July. 

 
 

17. Click the Save button, then click OK. 
 
 

Add a Vacant Position  
 
If you want to hold a specific dollar amount, but do not plan to hire someone in the near future 
for a specific position you can add a truly vacant line to hold dollar amounts.   
 

1. From the Maintain position data form, find a Not Budgeted or Vacant position. 
 

2. Right-click on the position and choose Edit Position Details. 
 

3. Click the FTE tab and verify the correct FTE is listed. 
 
NOTE: If you do not have a FTE or an inaccurate FTE is currently listed you will need to input 
the correct FTE by completing the following steps: 
 

a. Right-click anywhere on the assignment line. 
 

b. Choose Update FTE. 
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c. Enter the appropriate FTE. 
 

d. Click the Add button. 

 
NOTE:  If you permanently wanted to change the FTE of this position, you would delete the 
Effective End Date.  Otherwise, the updated FTE will return to the previous value after that end 
date passes. 
 

4. Click the Salary Tab. 
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5. Input a Salary amount to hold in the Override Option Value cell.  Please keep in mind 
that the fringes will automatically calculate so if you have an exact amount you need to 
hold adjust the number you input for fringe benefits. 

 

 
 

6. Click the Save button, then click OK. 
 

7. Go to the Distributions tab and input your distribution information and save.   
 

8. Run both the Calculate and Allocate procedures.   
 
 

Calculate and Allocate Compensation per Entity  
 
In Hyperion you have the option of calculating and allocating after each transaction or all at 
one at the end of all of your transactions. 
 
Complete these tasks to run the calculation and allocations after all of your transactions for 
the day.   
 
BEST PRACTICE 
Because of the amount of time it takes for the system to complete the running of these 
options, the Budget Office recommends running this at the end of all your transactions, 
rather than after each transaction.  
 
For large units, please run these rules at the four digit department level instead of the 
whole unit.  If these rules are run at the whole unit level, the calculations may cause the 
system to freeze. 
 

1. Navigate to: My Task List > Budget Preparation > Calculations > Calculate 
compensation budgets. 
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2. Click the Launch button. 

3. To change the entity, make sure the Version is Working and the Scenario is 
Budget.   

4. Select the appropriate Entity. 

 

5. Click your Department or College (if you are small size college) to select it.  

6. Click the right arrow to move it to the right side of the screen. 

7. Click the OK button. 

 

8. Click the Launch button. 

The system will create a popup let 
you know it was successfully run.  
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9. Once you see the rule was run successfully, click the Allocate compensation to 
general ledger accounts option. 

10. Click the Launch button. 

 

Before going into details on how to select the calculation criteria, let’s define some concepts. 

• Existing Employees are all of the pre-loaded employees. Existing Employees have a valid 
8-digit UFID. 

• Existing Positions are all of the pre-loaded positions. Any position that starts with 
“P_,” “P_A,” “SA_,” or “SB_” is an existing position. 

• To-Be Hired Employees start with “To_Be_Hired” followed by a digit.  
An example is: “To Be Hired 1.” 

• New Positions are all added to Hyperion by the Budget Office per requests from a 
unit. They start with “New Position.” An example is: “New Position 100.” 

Here are the three major instances when you may run the allocate compensation rule.  
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Each of these calculations correspond with different parameters, which are shown below. 
Review the list of employees/positions in your department. In most cases, you will have 
existing employees on existing positions. When you run the allocate compensation 
calculations for these instances, make sure you use the following parameters: 

Instance 1: Existing employees on existing positions  

 

If you have existing employees on existing positions, you need to set these 
parameters:    Make sure you select EMP_XXXX for Employee criteria and 
POS_XXXX for Position criteria. You can also type those values directly into the 
boxes. The Scenario should always be “Budget” and the Version should always be 
“Working” when you work in the All Funds Budget cycle. 

 
Instance 2: To-be-Hired employees on existing positions  

If you have To-be-Hired employees on existing positions, you need to set these 
parameters: Select New Employees (which represents all the To-be-Hired) for 
Employee criteria, and POS_XXXX for Position criteria. You can also type those 
values directly into the boxes. The Scenario should always be “Budget” and the 
Version should always be “Working” when you work in the All Funds Budget cycle. 
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 Instance 3: To-Be-Hired employees on new positions  

If you have To-be-Hired employees on new positions, you need to set these 
parameters:      Select New Employees (which represents all the To-be-Hired) for 
Employee criteria, and Total New Positions for Position criteria. You can also 
type those values directly into the boxes. The Scenario should always be “Budget” 
and the Version should always be “Working” when you work in the All Funds 
Budget cycle.  

The following steps show you how to make selections for Instance 1. You can follow these 
steps to make selections for instances 2 and 3 as well. 

11.  To change employee selection, click the Search button next to the Select Employee 
box.  

12.  Navigate along the branches to select employee branch for your organization.  

13. Click the right arrow to move it into the right side of the window. 



Hyperion Budgeting 62 

14. Click the OK button. 

 

Next, you will select Department or College as the Entity you want.  

15. Click the Search button next to the Select Entity box. 

 

16. Click the + button next to your Department. 

17. Select the Department. 

18. Click the right arrow to put it in the right side of the window.  

19. Click the OK button. 
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To change the position selection, click the Search button next to the Select Position 
box.  

 

20. Navigate the branches to select the positions for your organization. 

21. Click the right arrow to move it to the right side of the screen.  

22. Click the OK button. 
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23. Confirm Scenario and Version fields display Budget and Working. 

 
24. Click the Launch button. 
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Repeat these steps to make selections for Instances 2 and 3 if needed. 
 
NOTE: Besides searching to change your selection values, you can type in all the values 
(such EMP_1302, POS_1302 and HR_1302) directly to the search boxes. 
 
NOTE: If you are at the Support Unit Budget Request cycle, please make sure to select 
“SU_Budget” for Scenario and either “Working Flat” or “Working Optimal” for 
Version. 
 
 
Remember the BEST PRACTICE 
Because of the amount of time it takes for the system to complete the running of these 
options, the Budget Office recommends running this at the end of all your transactions, 
rather than after each transaction. 
 
 
Review Allocation Results 
To confirm the data has been processed successfully, you'll review a report to show you what 
was processed.  
 

1. Click the expand arrow next to Review entity compensation budgets to view the 
reports available.  
 

2. Click the Review Allocation Results option.  
 

3. View the results to make sure the Allocation process was run.  

 
In this example, you can see that position P_00005478 is displaying an error.  
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Correct Allocation Errors 
Whenever you see red cells in the Review Allocation Results report, that means you have an 
error somewhere with this person/position. 
 
Common errors are: 

• Allocate compensation to general ledger accounts procedure was not run 
• FTE not assigned 
• No distribution assigned 
• Distribution does not equal 100% 

 
1. From the Review Allocations Results report, right click on employee name. 

 
2. Choose Edit Employee Details. 

 
3. Check the FTE and Distribution tabs to check if above issues are found. 

 
4. If nothing appears within the FTE and Distributions tabs, calculate and allocate again. 

 
5. Confirm the error has been fixed. 

 
NOTE:  Position number P_00005478 no longer displays the red cell. 
 

 
Prior to submitting your requested budgets, the Push has to occur.  This will occur every 2 hours 
from 7 AM – 7 PM, Monday – Friday.  On Saturday & Sunday, the push will occur every 2 hours 
from 11 AM – 7 PM 
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All Funds Budget Submission 
 
 
 

 
 
Forms for Budget Submission 
 
Accessing Forms 
 

1. In My Task List, click the All Funds Budget expand arrow 
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2. You should see four forms. 

• Budget Worksheet  
• Budget Worksheet-Level 0 Accounts Only  
• Control Amount Used 
• HCP Push Validation 

 
 
HCP Push Validation 
 
This forms allows you to verify that “the push” has successfully completed and will display the 
salary dollars entered via Budget Prep.  You should verify this information prior to using the 
other two forms. 
 

1. Select HCP Push Validation form. 
 

2. Choose your Entity from the Entity dropdown field. 
NOTE:  You may need to search for the appropriate Entity. 
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3. Choose your FundBudRefSOF from the FundBudRefSOF drop down field. 
 

4. Choose your Dept Flex from the Dept Flex drop down field. 
 
NOTE:  If your ChartField string does not include Departmental Flex, this field must display “No  
Department Flex”.  Type in “no depart” into the search field, then choose No Department Flex 
from result list. 

 
5. Choose the appropriate program from the Program drop down field. 

 

 
 

6. Click the arrow button. 
 

 
Verify the displayed data is what you expected to see pushed from Budget Prep.  If the data is 
unexpected or in error, return to Budget Prep and make any needed corrections. 
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Budget Worksheet 
 
Salary data and fringe will automatically be populated from the Budget Prep push.  
 
This form displays account categories and accounts that expand and roll up along with totals at 
the bottom of the columns. Please note either this form or the Budget Worksheet – Level 0 
Account Only form can be used to input budget.  Both forms do the same thing they just have a 
different view. 
 
This form provides two years of actual expenditures, partial expenditures for the current fiscal 
year, and current year final approved budget.  The actual data include your expenditures only.   
NOTE: It is not required to budget at the 8 digit DeptID level or GL account level. It is your unit’s 
decision what level to budget. However, all data must be input at Level 0 members.  Your State 
Appropriation funds will be released at whatever level you budget here so please make sure you 
budget at whatever level you want your State Appropriations released at for the next fiscal year. 
 
If you plan to budget at a higher level, you also need to select one 8 digit DeptID. For example 
Enrollment Management, if you plan to budget at Office of Admission, Office of Registrar’s 
Office and VP of Enrollment Management areas, you can select DeptID 03020000 for Office of 
Admission, DeptID 03030000 for Office of Registrar and 03010000 for VP of Enrollment 
Management. You don’t have to go down to 03020100 or 03020300 deptID level. 
 
Similarly, if you plan to budget at GL account level, select the GL accounts you need to budget 
to and input your value. If plan to budget at higher level, for example, if you want to budget at 
Contractual Services level, pick one GL account under Contractual Services and input your 
value. You can either pick the GL account where you spend most of the Contractual Services or 
pick the GL account “71000 - Contractual Services”.  We will release State Appropriations at the 
600000 650000 and 700000 categories as we have in the past. 
 

1. Go to All Funds Budget > Budget Worksheet. Select your Department from the Entity 
drop down field (if needed). 
 

2. Select the appropriate FundBudRefSOF, Dept Flex (if needed) and Program. 
 

3. Then click the arrow button.  
 

 
NOTE:  The upcoming fiscal year appears first in the workspace, following by the previous 3 
fiscal years. 
 
The upcoming fiscal year will display 3 budget columns:  

• Control – this is the initial budget the Budget Office inputs for the new fiscal year 
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• Working – this is your working budget.  This is where you amake your plans for 
spending for the fiscal year. 

• Final – this is your final, confirmed budget for the fiscal year and the Budget Office will 
populate this column once everything has been finalized. 

 
Seeding Budgets 
 
Seeding budgets allows you to take budget data from current or previous fiscal year(s) and 
populate your Working budget for the upcoming year.  This process allows you to quickly add 
data to use as a starting point for budgeting without having to manually enter large amounts of 
budget data.  You can only seed at the 8 digit entity level, but you can seed at the rollup level for 
fund, program and deptflex. 
 

1. Right-click the upcoming fiscal year Working budget column header. 
 

2. Point to Seed Budget…from menu. 
 

3. Click from Current year (YTD) Actual. 

 
 

4. Scroll down to confirm non-salary accounts have seeded correctly. 
NOTE:  you will notice that Salary account (600’s) do NOT reflect the data from the current 
year Actual.  Salary data is pushed over from Budget Prep and is not editable in All Funds 
Budget (Budget Submission).  If you wish to make a change to salary data, you must 
return to Budget Preparation and make the change there. 
 
OPS and Operating Cost account should display the seeded data from the chosen fiscal 
year. 

 
NOTE:  Data may be entered manually into any white cell, instead of seeding, if desired. 
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Budget Worksheet-Level 0 Accounts Only 
 
Salary data and fringe will be automatically be populated from the Budget Prep push.  
 
This form only displays level 0 accounts and the accounts don’t expand (roll up).  You will also 
not see totals at bottom of columns. Please note either the Budget Worksheet form or this form 
can be used to input budget.  Both forms do the same thing they just have a different view. 
 
 
Populating Accounts 
 
The populating accounts procedure allows you to add accounts that were not previously used 
but will be needed and used in the future. 
 

1. From either the Budget Worksheet or Budget Worksheet – Level 0 Accounts Only, right-
click on the form and select Populate Account. 

  
 

2. From the Runtime Prompts window, indicate the account you wish to add. 
NOTE: Do NOT change any of the other fields in this window.  

 
 

3. Click the Account Select Members button. 
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You will drill-down and locate the account you wish to add within the left Member Name column.  
You can also type in the GL accounts directly into this field if you know which account(s) to add.   
 
If you add multiple accounts at once, separate each account with a comma. 

 
 
NOTE: When adding OPS Salary accounts please choose the second choice in the list as the 
first choice in the list is the pre-fringe benefit pool account and this account is no longer active.  
You will not be able to input data into this account cell once added. 

 
In this example, we are going to add an additional Travel account. 

 
4. Click the Total Accounts Expand icon. 

 
5. Click the Net Revenue and Expense Expand icon. 

 
6. Click the Total Expense Expand icon. 

 
7. Click the Operating Expenditures Expand icon 

 
8. Click the Other Operating Expenses Expand icon 

NOTE: Scroll down, as needed.  
 

9. Click the Travel and Training Expand icon. 

 
10. Click the 771005 object. 
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Once you have located the desired account, you will move it to the right side Member Name 
Column.  Only the accounts listed on the right side will appear in your worksheet. 

 
11. Click the Right-pointing Select arrow. 

 
12. Confirm the correct account appears on the right side. 

 
13. Click the OK button. 
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14. Click the Launch button. 

 
 

15. After launching the rule, you will receive a confirmation message. 
 

16. Click the OK button.  

 

17. Scroll down to verify the new account has appeared in your worksheet. 
 

18. Notice the new account now appears in the Travel and Training section. 
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19. Click within the Foreign Travel cell of the appropriate budget column. 
 

20. Enter the amount you wish to budget for that acount.  For this example, enter “100”. 
 

 
 

21. Click the Save button. 
 

NOTE:  This account will remain in your worksheet as long as you budget for it by placing a 
value in the cell. 

 
NOTE: If you decide you don’t need/want to budget for this account, you can clear the cell of all 
data and save the worksheet.  The account will no longer appear.  Or, if you enter a “0” into the 
cell the account will remain visable (as long as you did not suppress zeros in your user 
preferences) for the current fiscal year. 
 
Comments and Supporting Details 
 
To elaborate on or explain the data entered into any cell, you may choose to add comments or 
supporting details to the appropriate cell. 
 

Adding Comments 
Comments can be added to Level 0 or rollup accounts in both Budget Preparation forms and All 
Funds Budget forms. 
 

1. Right click on the cell to which you wish to add a comment. 
 

2. Choose Comments. 
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3. Click Plus-Sign to add a comment. 

 
 

4. Type your comment and click the Add button. 
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5. Notice you can see your lists of comments, who entered them and the date. 

 
 

6. Click the Close button. 
 

7. You can tell a cell has a comment attached by noted the icon that appears in the upper, 
right corner of the cell. 

 
NOTE:  Comments cannot be edited, but you can add comments over comments if desired. 
Hyperion keeps track of the history of all comments. 
 
Deleting Comments 
 

1. Right-click the cell that has a comment. 
 

2. Click the Comments option.  
 

3. Select the comment you wish to delete 
 

4. Click Delete. 
 

5. Click Close. 

 
 

6. Scroll down (if needed) to confirm the cell no longer displays the icon in the upper, right 
corner. 
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NOTE: Comments can be added to a level 0 member or parent member. 
 
 
Supporting Details 
 
This function allows you to add calculations or aggregate lines to your budget cells. For example 
Travel and Training, you can add the airfare cost, lodge, meals etc. to the cell as supporting 
details. 
 
Supporting Details are "calculating" explanations you can add to specific cells if desired. 
 

• Supporting details allows you to add in specifics of a cell's entry.  For example, if travel 
expenses are expected to be higher than normal, you can use Supporting Details to 
explain everything that goes into that value. 
Supporting details can only be added to “0” level cells, not to the roll up level. If you get 
the following error message, you are on a roll up level. 
 

 
 

Adding Supporting Details 
 

1. Right-click in cell to which you wish to add supporting details. 
 

2. Select the Supporting Detail option. 
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The Supporting Detail window will pop up for you to enter the supporting detail. 

 
 
You can add as many detail lines as needed.  In this example, we will add Airfare and Hotel 
costs. 
 

3. Type in the description of the first detail line in the Untitled field. 
 

4. Tab over and type in the amount of this detail line. 
 

 
 

5. To add an additional line on the same level, choose the Add Sibling button. 
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6. Type in a description for the second detail line. 
 

7. You will click the Add Child button if you need to include a calculated detail line.  In this 
example, we will input the calculations that contribute to the lodging costs. 

 
NOTE:  A child detail line will appear slightly indented from the previous parent line. 
 

8. Type in the description of the child line. 
NOTE:  In this example, we are calculating 32 days of lodging at $125 per night. 
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9. Click the Add Sibling button to add an additional detail line directly below Hotel Rate. 
 

10. Add the appropriate description for the new detail line. 
 

 
 

11. Double click the appropriate operator field and choose the correct the calculation 
symbol. 
NOTE:  In this example, we will be multiplying the Number of Days by the Hotel Rate to 
determine the expected In-State travel expenses. 
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12. Enter the appropriate number of expected travel days. 

 
NOTE:  The Total field will automatically calculate. 
 

13. When all supporting details have been entered, click the Save button. 

 
 

14. Scroll down and notice that the cell(s) with the supporting detail will now be blue/green. 
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Editing/Deleting Supporting Details 
 

1. Right-click the cell that has the Supporting Details you want to edit or delete. 
 

2. Choose Supporting Detail. The supporting detail window will pop up for you to edit or 
delete. 

 
 

3. Click the expand arrow and edit the values as needed or click the appropriate Delete 
button (Delete or Delete All). 

 
NOTE:  Clicking Delete All will remove all Supporting Details from the cell. 

 
4. Click the Save button. 

 
After saving, you will determine whether you wish to remove the value and the supporting 
details from the cell on the main screen, or just delete the supporting details. 
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• Choosing Yes  all data will be removed, including the cell value. 
• Choosing No  only the supporting details will be deleted. 

  
In this case, we will remove the supporting details, but leave the value in the cell. 
 

5. Scroll down and confirm the supporting value has been removed from the cell(s). 
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Control Amount Used 
 
This form is used to confirm that the total expense lines for both the Control and Working budgets 
equal.  After spreading budget dollars and before sending to CFO, you should confirm both 
budgets balance. 

 
If they do not equal, adjustments will need to be made prior to submitting to CFO. 
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Smart View 

Opening Smart View 
 
Smart View allows you to access and work in the same Hyperion forms in a more familiar Excel 
environment. Smart View is a plugin that must be installed on your computer prior to use.  
Contact your tech support if you need Smart View installed or if you haven’t upgraded Smart 
View to 11.1.2.5. 
 

1. Open Excel and verify you can see a Smart View tab at the top of the application 
window. 

 
Setting up Smart View Shared Connections URL 
 
Prior to using Smart View to complete all needed Budget Request Submission procedures, you 
will set up the appropriate Smart View connections. 
 

1. Click the Smart View tab, click the Options button and then select Advanced. 
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2. Type or paste the below URL in the Shared Connections URL field:  
 
https://prd4-budget.erp.ufl.edu/workspace/SmartViewProviders.  
 

3. Click OK. 

 
 
 
 
  

https://prd4-budget.erp.ufl.edu/workspace/SmartViewProviders
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Smart View Option Settings 
 
By default, missing data are displayed with #Missing. You can change the default display to 
other characters such as “-“. You can also make other formatting changes to Smart View. 
 

1. Click the Smart View tab, select Options, and select Data Options. 

 
  

Suppress rows that have no data. 

Suppress zeros. 

Suppress columns that have no data. 

 Display #Missing 
as other 
characters. 
Suggest to use “-” 
instead of “0”. 
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Connecting to Hyperion in Smart View 
 
You are now ready to connect to Hyperion using Smart View. 
 

1. Click the Smart View tab, click the Open button, and then click Smart View Panel. 

 
 

2. Select the Shared Connections option from the Smart View Home panel. 
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3. Type your GatorLink Username and Password. Click the Login button. 

 
 

4. Select “Oracle Hyperion Planning, Fusion Edition” from the Shared Connections 
Select Server drop down field. 
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You should see the Hyperion server at the top of the Shared Connections panel.  
 

5. Expand each level as follows: UBO_PSPB > Forms > All Funds Budget. Click Open 
Form on the bottom. 
 

6. Confirm you can see four All Fund Budget forms: Budget Worksheet, Budget 
Worksheet-Level 0 Account, Control Amount Used and HCP Push Validation. 

 
7. Select your Entity, FundBudRefSOF, Dept Flex (if needed) and Program from the 

Point of View (POV) bar at top of screen, if not already displayed. 
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8. You are encouraged to use the Smart View forms in the same order as you did in 

Hyperion.  Please refer to procedures HCP Push Validation, Budget Worksheet or 
Budget Worksheet-Level 0 Accounts as needed. 

 
 
Input and Save Budget Data in Smart View 
As with Hyperion, you can enter or paste data into any open cell. 
 

1. Once you have entered data, click Submit Data button to save and submit the data. 
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NOTE: 
The unsaved data appears orange in Smart View. When data is submitted, the cell turns yellow.  
 
 
Copy, Paste and Cut 
The copy, paste and cut function are the same as those in Excel. 
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Populating Accounts 
 
The populating accounts procedure allows you to add accounts that were not previously used 
but will be needed and used in the future. 
 

1. From the Planning tab, right-click on the form. 
 

2. Click Smart View > Populate Account 
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In this example, we will use Account Code 772000. 
 

3. Enter the appropriate Account code in the Select Account(s) to add: field.  
 

 
 

4. Click the OK button. 
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5. Note the “was successful” message that appears within the pop-up window.. 
 

6. Once this message appears, click the OK button.  
 

  
 

 
7. Confirm the account displays in the worksheet. 

 
You can now begin budgeting for this account. 

 
NOTE: If you decide you don’t need/want to budget for this account, you can clear the cell of all 
data and save the worksheet.  The account will no longer appear.  Or, if you enter a “0” into the 
cell the account will remain visible (as long as you did not suppress zeros in your user 
preferences) for the current fiscal year. 
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Adding Comments 
 
You can add Comments to cells in Smart View. Adding Comments is a simple, non-
calculating way to elaborate on the content of a cell. 
 

25. To attach a Comment, simply right click the cell to which you want to attach the 
comment. 

26. Hover over the Smart View menu item and select Cell Comments. 

 

27. Click Add Comment button. 
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28. On the right side box, enter "This is a comment." 
 

 
 
Adding a Comment offers a history record feature that keeps track of changes 
made to the comment. You cannot edit a comment but when you add a new 
comment you will be able to see the prior versions. 

29. Click the Save button in the middle of the popup window. You should see your 
name, timestamp and the comments show up on the left side.  
 

 

30. Click Close. 

31. Note the cell is outlined in blue. 
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Adding Supporting Details 
 

1. Right-click the cell to which you wish to add supporting details. 
 

2. Hover over the Smart View menu option and click Supporting Details button from the 
secondary menu. 
 

3. You will see similar menu items as those when you work in Hyperion. Please refer to 
Supporting Details section for steps to add, modify or delete supporting details. 

 
4. Confirm the cell contains the supporting details.  The cell will be highlighted blue/green. 
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Control Amount Used 
 
This form is used to confirm that the total expense lines for both the Control and Working budgets 
equal.  After spreading budget dollars and before sending to CFO, you should confirm both 
budgets balance. 

 
If they do not equal, adjustments will need to be made prior to submitting to CFO. 



Hyperion Budgeting 102 

Below screenshot shows the color coding for cells with comments, supporting details, and 
unsaved data.   
 

 
 
  

Cell with supporting 
details are blue/green 

   

Cell with 
comments  
has blue outline. 

Cells with unsaved data are 
highlighted in orange. 
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Security 
The following myUFL security roles are created for users.  
 
UF_N_BP_COLLEGE_PLANNER 
This role will grant access to view and update budget information in UF’s budget software at the 
college level. 
 
UF_N_BP_COLLEGE_VIEWER 
This role will grant access to view budget information in UF’s budget software at the college 
level 

UF_N_BP_DEPT_PLANNER 
This role will grant access to view and update budget information in UF’s budget software at the 
department level 

UF_N_BP_DEPT_VIEWER 
This role will grant access to view budget information in UF’s budget software at the department 
level 

To have access to Hyperion application, the support unit users should request the 
UF_N_BP_COLLEGE_PLANNER role. 
 
Users have read and write access to their responsible areas only. For example, the VP and 
Chief Information Officer user can only view and input budget for all IT departments, not other 
areas like Finance and Accounting. The SVP areas have read access to all the areas under 
their umbrella. For example, the SVP for Academic Affairs and the Provost Office can view the 
budget of DOCE, Graduate School, Library, International Center, Enrollment Management, 
CFO, Purchasing, Contracts and Grants, Finance and Accounting, and Student Affairs. 
However, the SVP for Academic Affairs and the Provost Office can only input and modify budget 
for the Provost’s Office, not the other areas just mentioned.  
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UBO_PSPB All Funds Budget Application 
Overview 
Dimensions represent the key components of the application. The UBO_PSPB All Funds 
Budget application contains the following dimensions: 
 

• Account 
• Entity 
• Fund/Budget Reference/Source of Fund 
• Program 
• Dept Flex 
• Scenario 
• Version 
• Year 
• Periods 

 
Account 

The Account dimension in UBO_PSPB is based on the account structure in PeopleSoft 
Financial system. Not all GL accounts in PeopleSoft Financial system are included in 
UBO_PSPB since the support units do not budget to every single GL accounts. To see 
the Account dimension hierarchy, go to one of the three forms. Expand and collapse the 
account to see the details. 
 
The account dimension will be revised each fiscal year. 
 

Entity 
The Entity dimension in UBO_PSPB is based on the Department structure in PeopleSoft 
Financial system. It is modified to reflect the budget reporting hierarchy.  
 

Fund/Budget Reference/Source of Fund 
This dimension should reflect your fund budget reference and source of fund 
combination for your expenditures. 
 

Program 
This dimension should reflect your program. 
 

Dept Flex 
This dimension should reflect your department flex if used. 

 
Scenario 

This dimension shows the data is for Budget. 
 

Version 
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This dimension shows whether you are working on and should always be Working. 
 

Year 
This dimension shows the fiscal year. 
 

Periods 
This dimension shows the month of the fiscal year from July to June. 
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